WENT 2000 – TRACK 2 – WORKING ONLINE

Introduction
3-b. Using Email-Working with Eudora 4.3


Using Email- Working with Eudora 4.3
Getting Started 

Downloading Eudora 4.3

For this training we will use Eudora version 4.3. First we need to download a free version of this software. 

Dowloading softwares from the Internet  can be done using a software called FTP client.  FTP stands for “file transfer protocol.”  It lets you transfer files from a server (remote host) to your own computer (local host). The two computers are usually joined physically on a network, usually through the Internet. 

You can also download materials from the Internet using a Web browser. This is quite easy, usually involving just a simple mouse click.

Downloading: Tips

Create a download directory for keeping resources downloaded from the Internet. You can use “Download” or “My Downloads” as directory name.

Setting up a separate download directory where you can keep all your downloaded files promotes a well-organized computer environment. By putting all your downloaded softwares in one directory, for instance, will make it easier for you to find them should you have to reinstall files at a later date. 
By creating a download directory you are also saving a lot of clean up time later. Most files that are downloaded from the Internet will be in a compressed format and when uncompressed will explode into many other files. By separating the downloaded files, it becomes easier to clean up file directories (to free up space in the hard disk) at a later stage with greater ease. 

Installing Eudora 4.3

Installing Eudora is also a straightforward process. One can start the installation by double clicking on the downloaded file. 

A more elegant way of installing however, is to:

· go the Control Panel of your Windows machine

· click Add/Remove Programs

· click Install

browse through your system’s directory  until you see the file you downloaded

· double click on the file

follow the rest of the steps

restart computer when done with the installation

Configuring Eudora 4.3 (step by step)

1. After your computer restarts, you will see an Eudora icon on your Windows desktop. This is the shortcut to starting the Eudora program.

2. Double-click the Eudora icon to open it. The New Account Wizard will open, showing the welcome screen. 

3. Click  Next to begin setting up your new email account.

4. Select the option to create a brand new email account. 

5. The New Account Wizard will guide you through the fields for which you need to enter setup information.

6. Click Next after filling out each of the following fields:

· Your Name — Enter your name as you would like it to appear in the From field of all of your outgoing messages from this email account, to indicate to your recipients whom the mail is from.

Example: pi villanueva

· Return Address — Enter the email address that has been assigned to you by your Internet Service Provider or your email administrator. This is the address that other people will use to send you email. Return addresses are generally in the form loginname@domainname. 

Example: pi@isiswomen.org

· Login Name — Enter the name that you will use to log in to this email account, if required. This name is provided by your Internet Service Provider or your email administrator, and it usually consists of the text that appears before the (@) sign in your return email address. 

Example: pi.

· Incoming E-mail Server — All incoming email messages are delivered to your incoming email account, which resides on a computer that runs your incoming email server. When your messages arrive at your mail account, Eudora picks them up and transfers them to your computer. Your incoming email server must use one of the two Internet mail communications protocols IMAP (Internet Message Access Protocol) or POP (Post Office Protocol). Most ISPs use the POP protocol, but it is always good to check with your service provider.

Example: kuanyin.isiswomen.org

If you chose POP in the previous setup window, click Finish in the final window and your new POP email account is set up.

When you have finished setting up your account via the New Account wizard, you are now ready to receive messages. However, you may need to take an additional step in order to send messages.

SMTP and POP

SMTP stands for Simple Mail Transfer Protocol. POP stands for Post Office Protocol. 

An SMTP server is the one that receives your outgoing messages and then delivers them to the recipients. 

A POP server on the other hand, is the one that delivers messages to you. That’s why accessing email is sometimes referred to as “popping mail.”

In most cases, the SMTP server and the POP server are one and the same machine. In which case, you don’t need to change any of the information you supplied Eudora’s New Account  Wizard. 

However if your SMTP and POP servers are different, then you will need to edit your Eudora configuration. One scenario wherein your SMTP and POP servers can be different is when you are trying to access your email through an ISP that is different from the one you normally use in your work place or home. 

Setting up SMTP server: (step by step)

7. From the Tools menu, choose Options.

8. Scroll through the Category icons, and choose Sending Mail. 

9. In the SMTP server field, enter the full name of the computer that runs your SMTP (outgoing) server

Example: apwin.sookmyung.ac.kr 

10. Save your settings and close the Options dialog box by clicking OK. You are now ready to send and receive mail in Eudora.

Starting and Quitting Eudora

1. To start Eudora, do the following:

On the desktop, double-click the Eudora icon or choose Eudora Email from the Start menu under Programs. 

11. To quit Eudora, do the following:

From the File menu, choose Exit, or press [Ctrl]+Q. 

Knowing your Interface

A computer program is basically a sequence of instruction for a computer. The program is what makes the computer seem smart. 

When we are using software programs, we are in effect making the computer perform certain tasks. To do this, programs have built-in user interface to make it easier for people to make the programs work. use work. 

There are two main kinds of user-interface: the command line, and the graphical. 

An example of command line interface is the old DOS. Programs like MS Word and Netscape have graphical user interface (GUI).

Eudora has a graphical user interface (GUI) which consists of windows and toolbars. The windows are so called because they are supposed to provide users a view of what the software is doing, and how things are organised by the software.

GUIs were created to make it easier for users to work with softwares and machines. They are designed to minimize keystrokes or typing and memorizing commands. Well-designed graphical interfaces are also intuitive, in the sense that users can easily guess how to use the program and how to move around the interface. 

Toolbars are so called because they are suppose to give users access to an array of tools for making the software do what it is supposed to do.

Program Window

When you open Eudora, what will appear on your desktop is the program window. The program window of Eudora will seem complicated, but the important thing to understand is that the program window is composed of a toolbar and four main windows or areas. All these windows can be opened or closed. To close them, click “x” in the corner of each window. To open a window: go to Tools, and select the Window you want to open. 

The Mailboxes Window

This is actually an area with five sub-windows for working with (1) mailboxes, (2) file browser, (3) signatures, (4) stationary, and (5) personalities

The Advertising Window

This is located below the Mailboxes window. Eudora 4.3 is provided free to consumers. Sponsor companies pay for the costs to produce Eudora, and in return Eudora provide advertising space in the program. This is the “sponsored mode” version of Eudora. The advertisements can be removed if the user pays a fee and register the program, or if the user decided to use a “light” version. There are not a lot of differences between the paid and sponsored mode or version of Eudora 4.3. The “light” contains no advertising, but  does not have all features that the paid and sponsored versions have. 

The Message Pane Window

The message pane is where you read and compose messages. The top half of the message pane is the message summaries window. It has various fields where important information about messages are displayed, such as: who sent the mail, when the email was received by the mail server, how large (in kb) each message file, the subject of the email. Icons will also appear on certain fields. 

The icons help “signal” the user about certain information relating to specific messages. (see index for meaning of icons)

The bottom half which shows the content of the messages, is the message preview window. One can open many message pane windows at the same time, and switch from one message window to another by clicking on the rectangular buttons that are at the bottom of the message window pane. Each of these rectangular buttons correspond to a specific mailbox.

Task Status and Error Window

This is at the bottom-most part of the program window. It has two sub-windows: the task status window and the error window. The task status window displays information on whether you are sending or receiving messages. The error window, on the other hand, displays error messages.

This window can be closed if one wants t have more space working with messages. The status window opens automatically when error occurs during sending and receiving of emails.

The Toolbar 

The toolbar is one other important part of the Eudora interface. This is the horizontal array of icon at the top most part of the program window. It represents specific functions in Eudora, very much like shortcut buttons. When you click on an icon, it will trigger the function that it represents. A user can customize the icons on the toolbar – both the icon itself and the function that is represented by an icon.

The following are icons with their corresponding function that are commonly found on the toolbar:

Icons
Function
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Delete. Puts email in trash mailbox 



Opens the  Inbox. The Inbox is where received messages are organized.
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Opens the Outbox. The Outbox is where sent messages are organized.
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Check for new email
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Reply to email (sender only)
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Reply to email (replies to sender as well as all recipients of email) 
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Forward (send the email to someone else)
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Open previous message in the mailbox
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Opens next message in the mailbox
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Attach a computer file to the email
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Search for keywords in an email
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Open the address book which contain information on your email contacts
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Print the email
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Context sensitive help; for getting information on how to use Eudora.
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Purevoice.  An advanced feature of Eudora which “reads” your email into the computer speakers.  This requires additional software and hardware installation, and is not covered in the course.  For more information on Purevoice visit Eudora’s website.

The Menu Bar

Aside from the windows and toolbar, there is also the menu bar. The menu bar is found on top of the toolbar, and is so-called because it gives users a menu or selection of tasks which the user want the program to do. Typically, Eudora will have the following main menu items:

File

Edit

Mailbox

Transfer

Special

Tools

Window

Help

Under each main menu item is a set of sub-menu items. Clicking on a main menu item triggers a “drop- down” box with a list of sub-menu items corresponding to a specific function. 

Some of the items or functions in the menu bar are also represented by an icon on the Toolbar.

Whether to use the menu bar or the Toolbar depends on the user’s personal preferences. Some people are more comfortable using the menu bar, and others prefer the Toolbar. 

There is also a way to create icons on the Toolbar that corresponds to functons that one often uses. (more about this in Module 6: Customizing Email)

Working with Messages

Creating an Outgoing Message 

An outgoing message is a message you send to someone else. The simplest way to create an outgoing message is to do the following:

From the Message menu, choose New Message. A new message window appears, the composition window.

1. Type a destination address 

2. Type a message

12. Type a subject header will
Box: Some style guidelines for email messages 

(or Just because it is electronic does not mean that an email message will not be judged by the way it looks.) 

Go slow on the bells and whistles.
Just because it has pictures and a colored background does not mean people will want to read your email. And even if they do, many email users may not be using email programs that will display your signature with that dancing baby.

 Keep it short. 
The length of a message might not seem important if you don't get much mail, but for people who receive a lot of e-mail there may not be time to read long messages.

Don’t forget the subject line.

Always use a subject line and try and make it as relevant as possible to your message. First impression matters. This is the first part of the message anyone sees when they open their e-mail program and many people choose whether or not to read the message on the basis of the subject line. 

Use paragraph breaks.

Email users need to exhale. A whole screen of text is not easy to read, so try and break your message up into short paragraphs with breaks in between. White space makes text easier to read.

Put a cap on your CAPS.

In the culture of cyberspace, messages written in all capitals are seen as shouting. This is because a message composed entirely of capital letters is uncomfortable to read. Use capitals sparingly. There are more *creative* ways of drawing people’s attention. 

80 by 60

It can be quite irritating to 

read a 

message that 

breaks 

in all the strange places. 

Keep your line length shorter than 80 characters and preferably no longer than 60 characters. 
Sign your email

Some mail programs don't receive the message header which generally includes your name and e-mail address. Always include your name and e-mail address at the bottom of your message. 
It might be tempting to sign your email with an ASCII drawing or a poem, but remember that some people pay for their email by the amount they download. Be considerate by keeping your signature short. 

Sending a Message Immediately

To send the current message, simply click the Send button or from the Message menu, choose Send Immediately. A progress window appears to show the progress of the transmission.

Queuing a Message

To queue messages is to send a message at a later time. A message that is queued is kept in the Outbox 

On the main message pane, a queued message is marked with the icon: [image: image15.png]



Queuing a message is very useful especially when your Internet connection is through a dial-up account, which tend to be expensive in developing countries. 

We can make “queuing messages” the default settings of Eudora by editing the program’s preferences or options. (more about this in Module 6: Customizing Email) 

Checking Mail (a.k.a. Downloading email)

Checking mail means getting your mail from the mail server. There are two ways to check your incoming mail server and transfer mail to your computer: automatically or manually. 

Checking for Mail Manually

You can manually check for new mail at any time either through the Menu bar or through the Toolbar:

1. Toolbar: Click on the Check Mail icon

2. Menu Bar: Click on the File menu, then selecting and clicking on Check Mail menu item. 

If you haven’t successfully entered your password since opening the Eudora program, you are prompted for it for each account being checked. A progress window is momentarily displayed at the top of the screen indicating that an attempt to reach your incoming mail account is being made.

Checking for Mail Automatically

Some organizations have local area network with round-the-clock Internet connections. In this scenario, checking mail automatically is applicable. 

To set up Eudora to automatically check your incoming mail account and transfer new mail, do the following:

1. From the Tools menu, choose Options.

2. Scroll and select Checking Mail. 

3. In the Check for mail every _ minutes field, enter the number of minutes that you want between mail checks. 

Tip: Fifteen minutes is a good minimum interval because checking mail more frequently puts an unnecessary load on your incoming mail server. If the field is empty, or is set to 0, mail is not automatically checked. If automatic checking is set, the Check Mail command under the File menu displays the next time that an automatic check is scheduled to occur.

There are also ways of controlling what happens to your mail on the server after you have checked mail. You can for example, “leave mail on server” which means that when you check mail you only get a copy of all new incoming emails while a duplicate copy is left on the server. These can be quite practical when you are accessing your emails from different machines. (more about this in Module 6: Customizing Email) 

Opening a Message in the Mailbox

The first step to reading mail is to open a mailbox. New mail messages are stored in a mailbox called In or Inbox.  You can open you new mail by double clicking on the Inbox icon in your Mailboxes window. When you do this, the Message window pane will open and show a list of all the messages in your Inbox. The bottom half of this window—which can also be called message preview window--will show the content of the message that is highlighted in the upper half of the message window pane.  

Double clicking an item in the message window pane will display the content of the message in a new window within Eudora. This is quite useful for minimizing eye-strain as the new window will be bigger than the message preview window. 

Responding to a Message
There are two ways to check mail, through the Menu bar or through the Toolbar.

1. Menu bar: From the Message menu, choose Reply. 

2. Toolbar: Click in the Reply icon

A new message window appears with the original sender’s address automatically placed in the To field of the header. All of the sender’s original text is quoted in the message body. This text can be edited as needed. Additional text can be added to the reply just as to any outgoing message, and the reply can then be sent or saved for further changes.

The sender’s text is quoted in the message with a left sidebar, also called an “excerpt bar.”

Messages that have been replied to are identified with a left arrow in the Status column of their message summary. 

Replying with Selected Text

It is possible to use a selected part of a message when replying to it. 

1. Highlighting the text you want to appear in your reply: In a received message, click and drag to highlight the text you want to include in your reply.

2. Once the selected text is highlighted, choose Reply from the Message menu or click the Reply icon.  The selected text now appears in your message reply.

13. Add more response, if needed.

14. To send, click Send (or Queue).

Forwarding Message

A message you receive can be forwarded to someone else. (A feature of email that can be both a blessing and a curse.)  Again this is done either by using the Menu bar or the Toolbar. 

To forward a message using the Menu bar, do the following:

1. From the Message menu, choose Forward.  

A new message window appears with your address in the From field, the original subject preceded by “Fwd:” and a space in the Subject field, the original sender’s text quoted in the message body. Make any changes you want, and enter the recipient’s address in the To field. The message can then be sent or saved for further changes.

Tip: Messages that have been forwarded are identified with a right arrow in the Status column of their message summary.
Managing your Messages

Sorting Messages in a Mailbox

The message summaries in the Message Window Pane are automatically sorted by date, in ascending order (the newest messages at the bottom of the mailbox). To change this, select the appropriate command from the Sort submenu under the Edit menu. 

An easier method is by clicking any of the column headings to sort by that column. 

To sort in descending order, hold down the Shift key and either select a command from the Sort submenu or click the column headings.

Tip: Sometimes sorting by Date can be incorrect. This usually happens with messages that were sent from computers with incorrectly formatted date fields, or unknown or incorrect time zones.

Deleting Messages

Deleting messages is very easy to learn, but often the hardest to practice. This is often because some people do not like parting with their emails. However, sooner or later our mailboxes will become large and brimming over with unimportant messages.

Deletion is done by selecting the message on the Message Window Pane, and pressing “delete” on the keyboard. 

Messages can be simultaneously deleted: 

If you click on a message, hold down shift key, and click another message, all the messages between the first and last message will be selected. Pressing the delete key will place all the selected messages in the Trash. 

To delete many messages that are not in sequential order, you hold down the ctrl key instead. This will select only the messages you click on while pressing the crtl key.  Again pressing the delete key will place all the selected messages in the Trash. 

If you want deleted messages to disappear permanently, go to Special menu and click on  Empty Trash. A shorter way of accomplishing this is to right-click on the trash icon, and then select and click on Empty Trash. 

Creating, Renaming and Deleting Mailboxes

Mailboxes are a boon to email users who want their messages sorted and stored in an organized fashion. Mailboxes can be created, renamed and deleted. What mailboxes you create and how many will depend on how you want your messages categorized and filed. 

To create a new mailbox, go to the Mailbox Menu and click on New. A dialog box will apear asking you to name the new folder. Type the name you want and click OK. 

Another way is to go to the Mailboxes Window, right click on the Eudora mailbox (or whatever mailbox is at the top), and select New.

To rename a mailbox, right-click on the mailbox you want to rename and select Rename.

To delete a mailbox, right-click on the mailbox you want to delete and select Delete. 

Moving Messages From One Mailbox to Another

There are several ways of moving a message from one mailbox to another. 

One way is by right-clicking on the message in the Message Window Pane, selecting ‘Transfer,’ then choosing the mailbox you want to transfer the email to. 

Another way is to “drag messages” from one mailbox to another using the message summaries or the Tow Truck icon in an open message window.

Drag a message summary to another mailbox by selecting the message summary (or summaries), holding down the mouse button,  and dragging  the summary into any open or minimized mailbox window, or any mailbox in the Mailboxes window. When you release the mouse button, the message is transferred.

To drag an open message to another mailbox, hold down the mouse over the Tow Truck icon and drag the message into any open mailbox or any mailbox in the Mailboxes window. When you release the mouse button, the message is transferred.
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